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Introduction
This student workbook is one of a range of eight titles designed to cover
topics for the refreshed PC Passport. Each title in the range covers the
required subject material and exercises for candidates studying PC Passport.
This workbook covers all three levels of PC Passport — Beginner,
Intermediate and Advanced.
There are a number of exercises associated with each subject and it is
recommended that centres download and use the sample exercise files
provided.
Each workbook will help prepare candidates for the assessments for the
refreshed PC Passport. It is recommended that centres use the most up-todate Assessment Support Packs appropriate for their type of centre, eg either
school, FE or work-based.
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Presentation Software
Presentation software is application software that allows you to create a
powerful presentation using slides, images, graphics, charts, tables, text,
video and sound to present information to an audience. It should include the
facilities to create handouts and notes for you and your audience to enhance
your presentation. The software needs to work with a projector, Smart screen
or other types of hardware, like a kiosk.
Microsoft PowerPoint is one of the most popular presentation graphics
applications used in business, offices, schools and colleges throughout the
world. You can use the presentation software’s own design templates so that
all the slides have the same look and feel, using a particular combination of
text styles, graphics and colours, or create your own design.
When selecting a template or creating a presentation you should consider: the
subject of the presentation; the style you want to adopt, eg professional,
contemporary; the location of the presentation, and the type of people in the
audience.
Some advantages of using a computer to create a presentation are:
♦ You can format the information on a slide using a variety of fonts, and add
lines and shading to emphasise important information.
♦ You can choose from a selection of pre-defined slide designs to give your
presentation slides the colour scheme and text style you want.
♦ You can print your presentation on a variety of different mediums such as
acetate and 35 mm slides, or use the computer to run a slide show.
♦ You can produce supporting documentation such as audience handouts
and speaker notes.
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Opening and Closing Microsoft PowerPoint
Opening PowerPoint
You can load PowerPoint in a number of ways. The most popular method is
using the Start menu, which is shown at the bottom left of the Windows
screen on the taskbar.
♦ Click the Start button, choose All Programs (or Programs if you don’t
use Windows XP) and then Microsoft PowerPoint.
Note: If you use Windows XP, and you use PowerPoint frequently, you may
also find it on the menu shown when you first click the Start button. This is to
make it quicker for you to launch the program.

Closing PowerPoint
When you have finished using PowerPoint, you should close it. You do this by
clicking File on the menu bar and then choosing Exit from the displayed
option menu.

PowerPoint Screen Elements
When PowerPoint is loaded, the application window will be displayed. Some
of the screen elements in this window can be switched on and off, so your
screen may look slightly different depending on your computer settings and
the machine you are working on.
PowerPoint has a title bar and menu bar that work in the same way as in all
other Windows applications.

Scroll Bars
The Scroll buttons at the bottom of the vertical scroll bar at the right of the
Presentation application window allow you to move to either the next or
previous slide in your presentation. You can also use the [Page Up] and
[Page Down] keys to move to the previous and next slides.
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Alternatively, if there is more than one slide in the presentation, you can move
to any slide by dragging the scroll box. When you drag the scroll box, a text
box appears displaying the number and title of the slide that will be displayed
on screen if you release the mouse button at that point.
The status bar appears at the bottom of the screen. The current slide number
and number of slides will be displayed at the left of the status bar.
If a design template is being used, its name will be displayed at the centre of
the status bar.
If there are spelling errors in your document the spell check indicator will show
as a wavy red underline. You can run the spell check by double-clicking this
indicator.

Toolbars
Every presentation application will have a number of different toolbars, each
displaying a collection of menu option buttons. You can choose to display or
hide toolbars using the View, Toolbars menu option. A number of toolbars
are displayed the first time you load and use PowerPoint: the Standard and
Formatting toolbars are initially displayed at the top of the screen under the
menu bar, the Drawing toolbar is at the bottom.
To find out what a toolbar button is used for, point to the button and pause for
a moment. A ToolTip will be displayed, showing a short description of the
button's function.

Slide Pane
Within the Slide pane you will see a picture of the current slide. Within this
pane you can add and amend slide content to suit your requirements.

Outline Pane
Within the Outline pane you can add slides and text. This pane is useful for
reviewing the overall structure of your presentation as the slide headings are
displayed there.

Presentations Student Workbook — Beginner/Intermediate/Advanced

3

PC Passport Support Materials

Notes Pane
In the Notes pane page view you can type speaker notes relating to the
current slide. These can then be printed to help you deliver the presentation,
or to provide the audience with additional information during or after the
presentation.

Opening a Presentation
If you want to work with a presentation that’s already been created, you have
to open it.
1 Open the file using one of these methods:
♦ Select the File, Open menu option, ie click the File menu and then the
Open option.
♦ Hold down [Ctrl] and press O.
♦ Click the Open button on the toolbar.
The Open dialogue box will be displayed.
2 Choose where the presentation is located, eg on the desktop or
somewhere on My Computer, by selecting an option from the Look in
drop-down list. You can display this list by clicking anywhere on the box or
the small arrow at the end of it. This is known as a drop-down arrow as
clicking it displays a drop-down list.
Note: The Places bar at the left of the dialogue box can be used to quickly
list the contents of the listed folders. Simply click the appropriate button.
3 If necessary, choose the disk where the presentation has been saved by
clicking it. The contents of that disk, including any files not stored inside a
folder, will be listed in the main window in the dialogue box.
4 Open the folder where the file has been saved by double-clicking its name.
For example, if the presentation is in the Projects folder, double-click the
Projects folder. The folder name will then appear in the Look in box and
its contents listed in the main window.
5 Once the folder you want is open and its name is shown in the Look in
drop-down list box, click the presentation name and then the Open button.
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Creating a Presentation
There are a number of different ways to create a presentation. When you first
open your presentation software, you may see a task pane with four types of
creation methods shown. To create a presentation, you choose which of the
four creation methods you want to use then click OK.

Constructing a Basic Presentation
If you created your presentation through the AutoContent Wizard, you then
choose which of the slides created by the wizard you want to keep, and add
any that the wizard missed out. You then replace the text on each slide with
your own text and add any other objects your presentation needs. To carry
out these tasks, follow the instructions given in this section and later in the
workbook.
If you created a blank presentation or one from a design template, your
presentation will contain only one slide known as a title slide. A title slide may
be used at the start of a presentation to introduce the theme and perhaps the
presenter.

Setting up the Presentation
Before you start adding slides and content to your presentation, you should
check that the setup of the presentation is specified, as this can make a
difference to the size of each slide and therefore to the content you can add.
You should also make sure the orientation of the slides is set as you want it.
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Select the File, Page Setup menu option then choose the medium the slides
are to be sized for. The drop-down menu gives a list and you select from this
list.

Adding Text to Slides
When a slide is first added to a presentation, it contains one or more
placeholders that let you add the various types of content available. For
example, the slide shown below contains a placeholder for the slide title, one
for text, and one for a graphic (this one is based on a template called Dads
Tie).

To add a title to the slide, you click the placeholder and type the title.
Note: You can also add and edit text in the Outline pane at the left of the
slide.

Using Bullet Points
Some text placeholders have been set up to format the text you enter as a list
of bullet points. When you press the [Enter] key, a new bullet point is added.
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The text in the block shown at the left of this slide was added by clicking the
placeholder and typing it. The placeholder was already set up to use the bullet
characters you can see here. Each of the minor points under the main points
(eg ‘End of financial year’ under ‘First Quarter’) is known as demoted, ie it’s a
minor point belonging to the major point above.

To demote a point, click the Demote button shown on the Formatting toolbar
or press [Tab].
To promote the point click the Promote button shown on the Formatting
toolbar or press [Shift] [Tab].

Changing the Slide Layout
Although you choose a layout for each slide as you add it, you can change the
layout whenever you like, even if you have already started creating your slide.
To do this, select the Format, Slide Layout menu option and choose the
layout you want to use.
Note: Although these layouts contain placeholders for different types of
objects, you can add any object to any slide regardless of whether there is a
placeholder for it.
You can also use the Slide Layout option from the Common Tasks button
on the Formatting toolbar to change the slide layout.
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Adding Slides to Your Presentation
When you want to add another slide to your presentation, select the Insert,
New Slide menu option or choose New Slide from the Common Tasks
button on the Formatting toolbar. Alternatively, you can press [Ctrl] M to add
a slide.
When you add a slide, you’ll be asked to choose a layout from those you saw
in the Slide Layout box at the top of this page. However, this time the box will
be called the New Slide box.

Deleting Slides
To delete a slide, display it then select the Edit, Delete Slide menu option.

Adding a Header or Footer
Headers and footers let you add information such as the current date, which
will constantly update a fixed date, or slide numbers to each slide in your
presentation. To create a header or footer, select the View, Header and
Footer menu option.
Tick any items you want to add and if you want to add any text of your own,
tick the Footer box and type it.

Importing and Exporting Files and Objects
Your presentation software can often make use of different file formats, as we
looked at earlier. These can be in the form of charts (from Lotus 123, or
Excel), inserting text from Microsoft Word, or other text editors. These
embedded files can be imported into your presentation from the originating
program, eg Microsoft Word, by using the export Send To option in the File
menu. It is often useful to create a dynamic link to the chart in the other
program. This allows you to get the most up-to-date version of the chart, or
spreadsheet, because when you make changes to the chart in its original
program like Excel, those changes are updated in the presentation through
the dynamic link.
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You can use the export Send To option in the File menu to also send a
presentation outline, handouts or notes to Microsoft Word or to an e-mail
program from within PowerPoint.
Objects that are embedded from another program like a chart can be
manipulated if the original source program is not available by using the
Microsoft Drawing object to amend or change the underlying object.

How to Save a Presentation
When saving files to your computer, you can choose to save them in a folder
on your computer's local hard disk, floppy disk or memory stick. If you are
attached to a network, you can also choose to save them in a folder on the
network. You can also choose to store them in a folder that already exists, or
create a new folder for them. Note: you may need to log in to the network to
access your files.
1 Choose to save the file using one of these methods:
♦ Select the File, Save menu option, ie click the File menu and then the
Save option.
♦ Hold down [Ctrl] and press S.
♦ Click the Save button on the toolbar.
The Save As dialogue box will be displayed.
2 In the File name text box enter a suitable file name. The following rules
apply when naming files:
♦ File names can be a maximum of 255 characters.
♦ Some characters cannot be used in file names. These include:
\/*?:;"|<>
♦ Within a single folder each file name must be unique.
PowerPoint adds a .ppt extension to all presentation file names. It may be
the case, however, that you do not see the file extension as its display
depends on how your system has been set up.
3 If necessary, choose a file format from the Save as type drop-down list.
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4 Specify where the file is to be saved, eg on the desktop or somewhere on
My Computer, by selecting an option from the Save in drop-down list.
You can display this list by clicking anywhere in the box or on the small
arrow at the end of it.
Note: The Places bar at the left of the dialogue box can be used to quickly
display the contents of the listed folders. Simply click the appropriate
button.
5 If necessary, choose the disk where you want to save the file by clicking it.
The contents of that drive, including any files not stored inside a folder, will
be listed in the main window in the dialogue box.
6 Open the folder where the file is to be saved by double-clicking its name.
For example, to store the file in the Projects folder, double-click the
Projects folder. The Project folder name will then appear in the Save in
box and its contents listed in the main window.
If you want to create a subfolder inside the one shown in the Save in box,
click the New Folder button. A new folder will appear in the file and folders
list, ready for you to type a unique name. Type the new folder name then
press [Enter].
7 Once the folder you want is open and displayed in the Save in drop-down
list box, click the Save button.
Note: When you save a file that has been saved before, PowerPoint assumes
that you want to save it on top of the previous version and so doesn’t ask you
for a file name or a location. If you want to save another copy of the file, use
the File, Save As menu option, which will always ask you for a file name and
a location.
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Printing a Presentation
Your presentation can be delivered in a number of different ways. For
example, you may choose to run a slide show using a multimedia projector in
front of a ‘live’ audience, or perhaps you will want it to run unattended on a
kiosk so that people who are passing can view it. Alternatively, you may print
your presentation either full-sized, with the notes you’ve added to the pages,
or in the form of audience handouts that can be given to your audience
before, during or after the presentation.
Later in the course you’ll learn about running slide shows, both manually and
automatically. Here you’ll learn about printing your slides.

How to Print a Presentation
Earlier you learned about page setup so that PowerPoint knows what output
medium is to be used for this presentation. Here you’ll learn about printing
your slides either as full-sized slides or as handouts for your audience.
1 Select the File, Print menu option or press [Ctrl] P.
The Print dialogue box will be displayed.
2 Look in the Name box in the Printer group and ensure that the correct
printer has been selected. If not, click the Name drop-down button to
display the list of available printers, and select the correct one.
3 Complete the dialogue box:
Print range
All: Select this option to print every slide in the presentation.
Current Slide: Select this option to print only the current slide.
Custom Show: If your presentation contains custom shows and you want
to print one of these, choose this option and the name of the show from
the drop-down list.
Slides: Select the Slides option and enter the range of slides you want to
print. For example 1, 3, 9 would print only these three slides, 2-5 would
print slides 2-5 inclusive.
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Selection: Select this option if you have selected one or more slides in
Outline or Slide Sorter view.
Number of copies: Enter the number of copies required into the Number
of copies text box.
Collate: This option can be used when printing multiple copies. Tick the
Collate box to print one entire copy of a selection before starting another
copy.
Print what
Slides: Print the selected slides, using a new page for each animation
effect.
Handouts: Print audience handouts (miniatures) for the selected slides.
Select how many miniatures you wish to print per page and the order in
which they should appear on the page.
Notes: Print Speaker notes for the selected slides.
Outline view: Print the Outline of the selected slides.
Greyscale: To have PowerPoint substitute shades of grey for colour,
select this option.
Pure black and white: Tick this box to print all shades of grey as either
black or white.
Include animations: Will print multiple pages for each slide that has
animation set up so as to illustrate how the objects will appear as the
animation sequence runs.
Scale to fit paper: To ensure that the selected slides fit onto the paper to
which you are printing, tick the Scale to fit paper box.
Frame slides: To add a thin border around slides, tick the Frame slides
box.
4 Click OK to start printing.
Always check if your printer is functioning correctly before sending any file to
print — that it is not out of toner or ink cartridges, that it is not out of paper, is
offline or switched off.
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Exercise 1: Creating Your First Presentation
1 Open PowerPoint.
2 Click From Design Template found on the task pane.
You are now given a display of the various templates available.
3 Choose any template. (We have used the Dads Tie template in our
example.) Now you are asked to choose a layout for the first slide in this
presentation.
4 The Title Slide layout is already selected, so click OK to create a new
presentation containing one slide that uses this layout.
Notice that the title slide has two placeholders, and you can see from the
text within them that it has been formatted with colours that match the rest
of the slide as well as font types and sizes that are appropriate for their
use.
5 Follow these steps to check the page setup for this presentation.
Select the File, Page Setup menu option.
The presentation will be delivered via a slide show so check that this
option is selected from the Slides sized for list.
The other settings in this box need not be changed, so click OK.
6 Follow these steps to complete the title slide.
Click in the placeholder that reads Click to add title.
Type Making Presentations.
Click in the second placeholder and type Tips and Techniques.
Click away from the placeholders to see the text.
Note: You don’t have to use all the placeholders shown on a slide layout.
Only those you use will appear when you run a slide show or print the
slide.
7 Add a new slide to the presentation using the Insert, New Slide menu
option. Use the Bulleted List layout that’s selected when the box is
displayed.
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8 Add this information to the slide, noticing that the text also appears in the
Outline pane at the left:

9 Insert these slides:

10 Add these slides. The Content slide uses the 2 Column Text slide layout.
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11 Press [Ctrl] [Home] to return to slide 1 in the presentation.
12 Use the [Page Up] and [Page Down] keys to move from slide to slide.
13 Display slide 2 The Introduction.
14 Follow these steps to change the layout used for this slide.
Select the Format, Slide Layout menu option.
Select the Text and Clip Art layout then click OK.
The slide changes
so that the text is all
shown in a block at
the left and a
placeholder for a
clip art graphic is
shown at the right:
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You’ll learn about adding clip art later in the course.
15 Follow the instructions below to save this presentation.
Select the File, Save As menu option.
Make sure Making Presentations appears in the File name box.
Create a folder called ‘Presentation Work’ on your computer (your tutor will
indicate on which drive you should save your work).
Within the Presentation Work folder create another folder called ‘Your
Name’ — you may already have an area allocated to you by your tutor.
Create a folder called Student Files within your own folder under
Presentation Work.
Create a folder called PersonalStuff within your own folder under
Presentation Work.
Create a folder within PersonalStuff called Presentations. The file
structure should look like this:
Presentation Work

Your Name

Student Files

PersonalStuff

Presentations

Make sure Presentations is the folder name shown in the Save in box.
Click Save. Notice that the name of the file now appears in the title bar.
16 Close the presentation by selecting the File, Close menu option.

Using PowerPoint Help
Like all Windows applications, PowerPoint provides a built-in facility for getting
help when you need it.
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The Office Assistant is a built-in help system that you can use when you want
to know more about a particular option or how to complete a task. If the Office
Assistant is displayed, some of the prompts that are usually shown in dialogue
boxes appear in an Office Assistant balloon.
1 Select the Help, Microsoft PowerPoint Help menu option. Alternatively,
click the Office Assistant button at the end of the Standard toolbar, or
press the function key marked [F1]. An Office Assistant balloon will be
displayed.
2 Type your question into this What would you like to do? box. For
example, How can I add a new slide? and then click the Search button.
You will then be given a list of help topics to choose from.
3 Click your chosen topic and help text will be displayed or a list of headings
will be shown so you can select more specifically what you would like to
do. This is the text that’s displayed when you choose Create a new slide.

What’s This?
Using the What’s This? option available from the Help menu can also be
used to find out about a particular menu option or screen elements you see
within the PowerPoint window.
When you choose this option, you will see the mouse pointer change to look
like a pointer with a question mark attached. Select the menu option or click
the screen element you want more information about.

Copyright, Designs and Patents Act
Whenever you decide to create a presentation it is important before you use
any graphics, images, video clips or files that you check you are not infringing
the copyright of that object. Copyright laws exist to protect the people who
created the object and their permission must be sought before you can use
any piece of text, reference materials, image, clip art or video clip in your
presentation.
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The Copyright, Designs and Patents Act gives the creators of literary,
dramatic, musical and artistic works the right to control the ways in which their
material may be used. The rights cover: broadcast and public performance,
copying, adapting, issuing, renting and lending copies to the public. In many
cases, the creator will also have the right to be identified as the author and to
object to distortions of their work.
Copyright arises when an individual or organisation creates a work, and
applies to a work if it is regarded as original and exhibits a degree of labour,
skill or judgement.
Interpretation is related to the independent creation rather than the idea
behind the creation. For example, your idea for a book would not itself be
protected, but the actual content of a book you write would be. In other words,
someone else is still entitled to write their own book around the same idea,
provided they do not directly copy or adapt yours to do so.
Names, titles, short phrases and colours are not generally considered unique
or substantial enough to be covered, but a creation (such as a logo) that
combines these elements may be.

Types of Work Covered
1 Literary
Song lyrics, manuscripts, manuals, computer programs, commercial
documents, leaflets, newsletters and articles, etc
2 Dramatic
Plays, dance, etc
3 Musical
Recordings and score
4 Artistic
Photography, painting, architecture, technical drawings/diagrams, maps,
logos, etc
5 Typographical arrangement of published editions
Magazines, periodicals, etc
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6 Sound recordings
May be recordings of works, eg musical and literary
7 Films
Broadcasts and cable programmes

Copyright Notices
It is strongly recommended that you include one on your work. It will:
♦ announce that copyright exists in the work
♦ make it clear who is the owner
♦ deter infringement.
By having a copyright notice you are helping to prevent infringement
occurring. For more information on the current Copyright and Patents Act go
to: http://www.copyrightservice.co.uk/copyright/uk_law_summary

File Formats Used in Presentations
When you save a PowerPoint file it is stored in a particular format, complete
with the formatting that has been applied, the graphics that have been
included and so on. The file name you supply is given a .ppt extension (an
abbreviation added to the end of the file name to identify the file type) which
identifies it to PowerPoint as a PowerPoint file.
PowerPoint can both read and save your files in other formats. This is so that
you can exchange data with other programs that can’t read or create
PowerPoint’s own format.
So if, for example, a client uses a different presentation program that can’t
read PowerPoint files, you could save your work in another format that they
can read.
You may already have a version of the presentation stored at work, or are
using an older version of the software in a remote location. In this case use
the Save As option to give the presentation another name.
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Likewise, if PowerPoint can’t read a program’s file format (for example, a wmf
file format which is not supported in PowerPoint), save the work in one of the
formats that PowerPoint can read.
Here are some common file formats that PowerPoint can work with:
Earlier versions
of PowerPoint

If you share presentations with users of earlier versions of
PowerPoint, you can save the presentation in the appropriate
format by choosing it from the list.
Note: When the other user sends the presentation back to you,
PowerPoint recognises it as a presentation and so will open it
like any other PowerPoint file. These files will have a ppt file
extension no matter what the version of PowerPoint you are
using.

PowerPoint Show

When you use this format to save a presentation, the resulting
file will always open as a slide show. This file will always have a
pps file extension and will always open in Slide Show view.

Outline

You can open an outline document from another application
such as Word or Excel. The outline is used to create slides and
structure their contents.
You can also save a presentation as an outline document.

Design Template

Design templates are included with PowerPoint and can also be
downloaded from the web. They normally have a pot file
extension.

Web Pages

This is a format that can be used for saving presentations.
When you use this format, an HTML file and a folder containing
supporting files will be created. These can then be uploaded
and displayed via the internet or an intranet.

Text, CSV, RTF

Most types of text files, Rich Text Formats, or Comma
Separated Files can also be incorporated into presentation
software.

To open or save a workbook in a format other than the standard PowerPoint
Workbook format, use the Files of type drop-down list to choose the
particular format you want to work with.

Graphic Files
Often when you use graphics in your presentation, you have to consider their
size and quality as these can affect the quality of your presentation. If the
graphic is of poor quality it will be obvious to your audience, however if it’s too
big, it could take some time to appear on the screen during your presentation.
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If you use a number of large graphics, you might find that the size of the
presentation file becomes a concern — perhaps you have to transfer it to your
presentation hardware via a floppy disk or memory stick but it doesn’t fit so
you compressed it.
You often find that you have to trade off between size and quality to find a
compromise that works for you.

Type

Description

Size1

Quality2

JPEG

This is a compressed graphic
format.
Joint Photographic Expert Group
images are mainly used for saving
high quality photos for use on the
web. The greater compression used
when the file is saved, the more
information is lost and so the lower
the quality of the photograph.

If you saved a
graphic in this
format using the
largest number of
colours available,
this would be the
middle file size.

This format can
use an infinite
number of
colours and so
can be the
highest quality.

GIF

This is a compressed graphic
format.
CompuServe/Unisys Graphics
Interchange Format is mainly used
for saving icons and other small
graphic files and uses anything from
two colours to 256 colours, so it’s
not ideal for photographic images to
be saved this way.
Note: There is also a type of GIF
that shows movement. This is called
an animated GIF. It works by
combining several images into one
file, and programs that support
animated GIFs work by cycling
through the images in the file. This
file type is often used on the internet
as it is supported by most of the
main web browser programs and is
quite a bit smaller than its rivals.

If you saved a
graphic in this
format using the
largest number of
colours available,
this would be the
smallest file size.

This format can
use up to 256
colours.

1

These notes refer to the same file size being saved in all three formats.
Each of the graphic types can use up to the number of colours stated, but they can be saved
with fewer colours to save file storage space or to make them appear faster on the screen.
2
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BMP

This is an uncompressed graphic
format which means that, for
presentations anyway, it’s not the
best format to use, especially for
large graphics. Another issue with
bitmap images is that they do not
scale very well.
Bitmaps are made up of individual
pixels and take a large amount of
storage space.

IMG

Normally associated with image
files, .IMG is the filename extension
usually used for the disk image of
memory sticks and hard disks.

If you saved a
graphic in this
format using the
largest number of
colours available,
this would be the
largest file size.

The number of
colours for a
bitmap is
expressed as its
colour depth and
is measured in
bits (typically 16,
24 or 32 bit). A
graphic with a 16
bit colour depth
would use up to
65,000 colours; a
32 bit graphic
could use up to
4,000 million
colours.

JPEGs and GIFs are the two most popular. CompuServe/Unisys who owned
the patent on GIF file formats did try charging to use this format, however the
patent in the United Kingdom, France, Germany and Italy expired on 18 June
2004. Consequently, the GIF format may now be used without charge.
Note: The number of dots per inch (or dpi) can also be a factor when
choosing graphics. Each image is made up of a number of coloured dots
(known as pixels). The higher the number of dots in every inch, the clearer the
image will be. However, the higher the dpi the larger the file size.
The dpi may also raise an issue if you resize the original graphic and print
your presentation. If you resize a 72 dpi graphic, the 72 dots will be stretched
to the new size, which could distort the image. If you resize a 300 dpi graphic,
it will also be distorted but, because it started out with more dots per inch, the
distortion won’t be so obvious. This is only an issue when you print the
presentation, because your screen only shows 72 dpi anyway.
For more information about bitmaps and screen resolutions look at the
following link:
http://www.webopedia.com/TERM/B/bit_map.html
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Data compression methods vary for reducing the size of graphics files but
compressed data can suffer from the ‘lossy’ effect when decompressing the
file retrieves data that may well be different from the original, but is ‘close
enough’ to be useful in some way. Lossy data compression is used frequently
on the internet and especially in streaming media. ‘Lossless’ compression
allows the exact original data to be reconstructed from the compressed data.
For more information about compression techniques look at the following link:
http://en.wikipedia.org/wiki/Lossy_data_compression

Other File Types That Can Be Used in a Presentation
In addition to these files that PowerPoint can open and save, you may want to
add objects such as sound, graphics and video to your presentations. These
are known as multimedia files. They have different formats with different
characteristics and can be identified by their file name extension. Some
common formats in general use are given below.
.AU,
.wav,
.mp3

Files with these extensions are audio sound files. AU is the standard audio
file format used by Sun, Unix and Java. The wav format was developed
jointly by Microsoft and IBM and became the standard for sound used on
PCs as they can be played by nearly all Windows applications that support
sounds.
The mp3 format compresses sound data without losing sound quality and
so these files are smaller but just as sharp as their CD counterparts. Their
smaller size means that they’re ideal for transferring across the internet.

These are both compressed video file formats. The avi format is the
.avi,
.mpeg standard for Microsoft’s Video of Windows. The mpeg format is a higher
quality, compressed format.
.wmf

Another type of graphic file called a Windows Metafile Format.

.zip,
.sit

These formats are both compression formats. The zip format comes from a
compression utility called Zip, and the sit format comes from a compression
utility called Stuffit. These utilities are used to reduce the size of files so that
they can be more easily sent electronically. The recipient of these files uses
the appropriate utility to decompress the file or files contained in the file they
received.

Important! Just because multimedia files are available on the web doesn’t
mean that you have the right to download or copy them — they may be
copyrighted. Check the site thoroughly for a copyright statement. If in doubt,
do not download or use the file. You should also consider acknowledging the
source of the data.
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Different Views
When you first load PowerPoint, the arrangement of the Slide, Outline and
Notes panes you see on the screen is called Normal view. As you’ve seen,
this view can be used for adding slides, adding slide content and adding
notes. Another view that can be used is called Slide Sorter view. In slide
sorter view you see all your slides in miniature, making it easier to add and
delete slides as well as to change the order they appear in. It can also make it
easier to add some of the slide show effects that you’ll learn about later in the
workbook.
To switch to Slide Sorter view, select the View, Slide Sorter menu option or
click the Slide Sorter View button shown at the bottom left of the PowerPoint
window as indicated above.
There are actually five views including Normal and Slide Sorter:

Normal View
This is the view you see when you initially start PowerPoint. The screen is
divided into three panes: Outline, Slide and Notes.

Slide Sorter View
This view shows each slide as a miniature as you saw on the previous page.
You can’t change the content of a slide in Slide Sorter view.

Slide Show View
This is the view used to run an on-screen presentation.

Slide View
This view focuses on the graphical slide, shrinking the Outline pane to a small
panel at the left-hand side of the screen.

Outline View
This view focuses on the text held within each slide so you can concentrate
on the text content and structure of your presentation. The Outline pane at the
left side of screen is increased in size and the graphic slide reduced in size.
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Changing View
To change view, select the appropriate View menu option at any time or click
the View button at the bottom of the PowerPoint window.

Formatting Text
When you add text using a text placeholder, the text is formatted according to
the options that have been selected for the design template and slide layout.
You can alter the formatting of any text within your presentation.

Applying Character Formatting
Each character of text in your presentation can be given different character
formatting attributes, eg underlining, italics or a different font.
Before you can apply these attributes, you must select the text to be affected
by the changes. If you want to apply attributes to all the text in a placeholder
or text box, you can select it by holding down the [Shift] key and clicking the
text once.

If you want to apply different formatting attributes to key words rather than all
the text, click and drag over the character(s) you want to format. The text you
drag over will appear highlighted.

Once you have selected the text, you can change the required formatting
attributes using either the buttons on the Formatting toolbar as described
below, or by using the Format, Font menu option.
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Adjusting the Alignment of Text
Within a text box or a text placeholder, you can change the alignment of the
text so that it is displayed at the left, the right, or centred within the text area.
Select the text or text box and click the required alignment button.
Align Left

Align Centre

This text is left-aligned

This text is centre-aligned

This text is right-aligned

Align Right

How to Apply Formatting Using Format Font
1 Select the text using one of the methods outlined previously.
2 Select the Format, Font menu option or right-click the selected text, and
then choose Font from the shortcut menu.
The Font dialogue box will be displayed.
3 Select the effects you want to apply from this dialogue box.
4 Click OK.

Adjusting Line Spacing
The spacing between lines within a paragraph and between paragraphs can
affect how the text looks on a slide. You can decrease the line spacing in
order to make the text fit better or increase it to make the text more readable.

In this example, the line spacing is set to
1.25 lines. Therefore, you can fit more text
into a smaller space.

In this example, the line spacing is set to
1.75 lines. Therefore, text uses more
space.
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How to Change the Line Spacing
1 Place the insertion point within the paragraph to be changed.
Note: You can select more than one paragraph to be changed by clicking
and dragging over at least some of the text in each paragraph.
2 Select the Format, Line Spacing menu option.
The Line Spacing dialogue box will be displayed.
3 Select the required line spacing.
Line spacing: will allow you to increase or decrease the space between
the lines within a paragraph.
Before paragraph: will allow you to increase or decrease the space above
the paragraph.
After paragraph: will allow you to increase or decrease the space below
the paragraph.
4 Click OK.
The selected spacing will be applied to the selected paragraph(s).

Adjusting Paragraph Indents
Using the ruler, you can apply indents to paragraphs. To display the ruler,
select the View, Ruler menu option. To set indents, select the paragraph(s)
you wish to format and then drag the indent markers that are shown on the
ruler to the required positions.

Using Word Wrap
It may be when you add text to shapes, the text wraps inside the shape.
However, if this isn’t the case, you can change the settings to apply word
wrap to any shape that needs it.
Text box with no word wrap applied:
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Text box with word wrap applied:

To Apply Word Wrap
Select the text box and right-click to display the shortcut menu. Select the
Format Text Box menu option and then click the Text Box tab displayed
within the displayed dialogue box. This dialogue box displays all the options
controlling how the text appears within the text box.
Note: Although this instruction refers to word wrapping in text boxes, the
same settings can be used for any AutoShape that can contain text. When
you right-click an AutoShape, choose Format AutoShape from the shortcut
menu.

Checking Your Spelling
You may have noticed as you type that red wavy lines are sometimes
displayed under some of the words. This is because PowerPoint’s Check
spelling as you type facility is switched on and PowerPoint doesn't recognise
these words. It may be that you’ve typed the word incorrectly, or it may be
simply that PowerPoint can't find the word in its built-in dictionary.
Note: To switch on this facility, select the Tools, Options menu option and
display the Spelling and Style property sheet. Tick the Check spelling as
you type box.
When you right-click a word that has a red wavy underline, a shortcut menu
relating to the spelling of the word is displayed.
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At the top of the shortcut menu will be any words that PowerPoint can suggest
instead of the one you’ve typed. To replace the word with one of these
suggestions, click it in the shortcut menu.
Alternatively, if the spelling of the word is correct you can choose either to
ignore it here or to add it to PowerPoint’s custom dictionary so that it's not
highlighted as an error again.
To carry out a full spelling check of the presentation, select Spelling. This
option is discussed below.
If you prefer not to check your spelling as you type, you can check it any time
using the Tools, Spelling menu option or by pressing [F7].

How to Check Spelling
1 If only part of the presentation is to be checked, choose Slide Sorter or
Outline view and select the required slides.
2 Select the Tools, Spelling menu option or click the Spelling button shown
on the Standard toolbar. Alternatively, press [F7].
PowerPoint will begin to check the spelling, comparing each word against
the dictionary. If any word is not found in the dictionary, the Spelling
dialogue box will be displayed.
The word that can't be found is displayed in the Not in dictionary text box
and highlighted on the slide.
3 Specify what is to be done with the selected word.
Ignore: Click the Ignore button to ignore this occurrence of the word and
carry on. This could be used when the word is a proper name or a
correctly spelled word that is not in the dictionary.
Ignore All: Click the Ignore All button to ignore this and every other
occurrence of this word in the presentation.
Suggest: If necessary, click the Suggest button to display a list of
replacement words in the Suggestions list box.
Change: Accept one of the alternatives shown in the Suggestions list box
by clicking it, or type an alternative into the Change to text box, then click
Change.
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Change All: Replace all occurrences of the word with one of the
alternatives by clicking the alternative in the Suggestions list box, or
typing an alternative into the Change to text box, and then clicking the
Change All button.
Add: Add the word in the presentation to the custom dictionary by clicking
the Add button.
AutoCorrect: To add this word and its replacement to the AutoCorrect list,
click this button. From now on, PowerPoint will automatically replace the
word each time you type it.
Close: Click the Close button to stop the checking process and return to
the presentation.
4 When the check is complete, a prompt will be displayed.
5 Click OK to acknowledge this prompt.

Bullets and Numbering
When typing text onto slides with the Bulleted List layout, bullet points will be
added for you automatically. To add or remove bullet points from text, select
the required text and then click the Bullet button shown on the Formatting
toolbar.
If you would rather apply numbering, select the text and then click the
Numbering button shown on the Formatting toolbar.

Changing the Bullet and Number Style
If you have applied bullets or numbers to your text but would rather have them
displayed in a different style, you can do so using Format, Bullets and
Numbering menu option. First select the text you wish to format and then
choose the Format, Bullets and Numbering menu option or right-click the
selected text and choose Bullets and Numbering from the shortcut menu.

Selecting an Alternative Bullet
Select the bullet you would like to use from the dialogue box options shown.
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Selecting an Alternative Numbering Style
Select the numbering style want to use from the dialogue box options shown
below.

Copying Formatting
Once you have formatted one piece of text, you can apply the same
formatting attributes to other text within your document. There are two ways
you can do this: using the Format Painter; and the Edit, Repeat menu option.
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How to Use the Format Painter
1 Select the text that has been formatted with the attributes you want to
copy. (You can either drag over the text or hold down [Shift] and click the
text frame to select it.)
Note: If you click and drag over part of a paragraph, the formatting that will
be copied will include only character formatting such as the font, the size,
colour, bold, italic and so on. If you select a whole paragraph you will copy
the paragraph formatting too. This includes attributes such as alignment,
bullets/numbering, spacing and so on.
2 Click the Format Painter button once if you want to copy the formatting to
one other piece of text, or double-click if you want to copy the formatting to
more than one. The mouse pointer will change to show a paintbrush.
3 Using the mouse pointer, select the text you want to apply the formatting
to.
4 If you double-clicked the Format Painter, you can now continue to apply
the formatting to other text as required.
Once you have finished copying the formatting, click the Format Painter
again, or press [Esc] to switch it off.

How to Use the Edit, Repeat Menu Option
1 Once you’ve applied the formatting to one piece of text or object, select
the text or object that’s to have the same formatting applied.
2 Select the Edit, Repeat menu option. Alternatively, press [F4] or
[Ctrl] Y.
The last action that you carried out is applied to the currently selected text.
Note: When using this menu option to apply formatting attributes previously
applied to other text, the formatting applied will depend on the method
previously used to apply it. For example, if you applied a number of formatting
effects using the Format, Font menu option, then all of the formatting
attributes chosen will be repeated in a single step. However, if you used the
Formatting toolbar or keyboard shortcuts to apply the original formatting,
PowerPoint will repeat only the last effect you applied.
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Working with the Outline Pane
How to Re-order Slides and Points
1 Select the slide or bullet point whose position you want to change, then
click in the left margin and drag to the new position.
As you drag the mouse, the pointer changes to

and a horizontal line

appears showing where the slide or point will be positioned if the mouse
button is released at that point.
2 When the line is at the required position, release the mouse button.
Remember you can also use Cut and Paste as well to remove text to a
different slide location. All the normal formatting tools are available when
organising your slides in Outline view or in Slide Sorter view.

Collapsing and Expanding Slide Detail
If you have a lengthy presentation containing many slides, you may find it
useful to hide the detail of some of the slides so as only to display the
headings. This might make it easier to review the structure of your
presentation. To hide the slide detail, simply double-click the slide icon. You
can redisplay the slide detail by double-clicking this icon again.

Changing the Design Template
By selecting an alternative design template, it’s possible to change the look of
your entire presentation at any time. Any information already entered when
you change the design template will be converted to the new template format.

To Apply a Design Template
Select the Format, Apply Design Template menu option or click the
Common Tasks button and choose Apply Design Template.
Select a design template from the displayed list and then click the Apply
button.
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Using the Clip Art Gallery
To add pictures, sounds and movies to your presentation, you can insert them
either directly from a file or from the Clip Art Library. The Clip Art Library
contains a selection of images that are installed as part of the PowerPoint
installation programme and you can use these images in your presentations
to enhance their appearance.
If you have selected a slide layout that incorporates a Clip Art placeholder, all
you need to do to insert an item is double-click the placeholder.
On the other hand, if you want to insert an item from the Clip Art Library and
the slide does not show a placeholder, you can click the Clip Art button
shown on the Drawing toolbar.
If you have chosen to access the Clip Art Gallery by clicking the Clip Art
button, the Clip Art dialogue box will be displayed. Once you have found an
image you want to use, click it and four buttons will appear. To insert the
selected picture, click the Insert Clip button.
Note: If you are inserting a clip art image as a result of double-clicking a Clip
Art placeholder, you need only select the image you want and then click the
OK button shown at the bottom of the dialogue box.
Once you have selected to insert your clip, close the Insert Clip Art dialogue
box by clicking the Close button.

Importing Clip Art
If you have images that you wish to add to the Clip Art Gallery, you can
choose to import them. To import a clip art image, click the button shown at
the top of the Insert Clip Art dialogue box and then select the name of the
image file you wish to add to the Clip Art Gallery. Select the file you wish to
import and click the Import button. You will then have a chance to enter
keywords to associate with the image to make it easy to search for it. You can
also select which clip art category you would like to add it to. Once you’ve
finished, click OK and the image will be inserted into the gallery.
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Selecting Objects
Any object you add to a slide, including clip art, text, charts and drawings, can
be moved, resized and deleted as required. To work with an object you must
first select it. You can do this by clicking the object.

To Select Multiple Objects
You can select more than one object by holding down the [Shift] key and
clicking each. Alternatively, while the Selection Tool button is chosen on the
Drawing toolbar, you can click and drag the mouse, as if you are drawing a
rectangle around the required objects. As you drag, a dotted outline will be
displayed.
Only objects that fall entirely inside the outline will be selected.

To Select All Objects on a Slide
To select all objects on a slide, choose the Edit, Select All menu option or
hold down the [Ctrl] key and press A.

Resizing and Moving Objects
Resizing Objects
Any object added to a slide can be made smaller or larger.
To resize an object, position the mouse pointer on one of the selection
handles, click and hold down the left mouse button, then drag to resize it.
As you drag, a dotted outline will be displayed. When the outline is the correct
size, release the mouse button.

Moving Objects
To move an object, point to it, hold down the left mouse button and drag. As
you drag, the mouse pointer changes to the crosshair symbol and a dotted
outline appears representing the selected object. When you have dragged the
dotted outline to the required position, release the mouse button.
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Working with Images
You can add various types of images (from clip art to pictures or video) to
your presentation. You need to know how to correctly size the image and
ensure it takes up the minimal amount of space in your presentation. Image
and video files can be quite large. When you insert an image, you may wish to
format it by brightening it or perhaps changing the colours used in the image
to colours that better suit your chosen design template.
The picture toolbar displays a number of buttons you can use to format a clip
art image to suit what you need. Often when you import images into your
presentation they will appear too big and you must resize them to fit onto your
slide.

Image Warping
Image warping digitally manipulates the image and distorts any shapes within
the image. These distortions can come from a variety of methods and can
include wrapping an image around shapes by stretching, curling or bending
the image.

Feathering
Feathering is a technique used in computer graphics software to smooth or
blur the edges of a feature. It is most commonly used in paintbrush software
tools to soften the edges of a foreground image so it blends into the
background image with less contrast.

Layers
Layers are used in digital imaging software to separate different elements of
an image.
For image warping, feathering and layering you may need to use specialist
software before importing the image into your presentation, but you should
understand how these methods can alter your images.
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Cropping Images
Resizing images to make them larger or smaller can be done using the crop
tool. Cropping images allows you to make a graphic smaller by cutting off the
parts you don’t want.
1 Select the image you wish to crop.
2 Click the Cropping button on the Picture toolbar.
3 Position the cropping tool icon on a selection handle and drag to crop to
the required size.

Using Colour Patterns and Filters
On slides, images, clip art and drawing objects you can make use of the
colour scheme tools to add different colour schemes, patterns and gradients
of colour to objects, text and backgrounds for your presentation.

Working with Drawings and Objects
The Drawing toolbar gives you access to a selection of drawing tools that can
be used to create different shapes, arrows and text labels which can be added
to your presentation. Other buttons on the toolbar also allow you to change
the format of drawn objects.

Drawing Shapes
To draw a shape using one of the drawing tools, select the tool, move the
mouse pointer to the required position, then click and drag to draw the shape.
To draw perfect squares or circles, or straight lines at 45º intervals, hold down
the [Shift] key as you drag the mouse.
Click at the top left corner and drag diagonally to the bottom
right corner. Holding down the [Shift] key creates a perfect
square.
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Click at the top left corner and drag diagonally to the bottom
right corner. Holding down the [Shift] key creates a perfect
circle.
Click at the point where the line should start then drag to the
finish point. Holding down the [Shift] key creates a straight
line at 45o intervals.
Click at the point where the arrow should start and drag to
the finish point.

Adding Text Boxes
To add a text box to a slide, you can use the Text Box tool. Click this button
and then drag and click to mark where the text is to appear. When you
release the mouse button, the insertion point will be flashing in the text box.
You can then type the required text.
You can change the colour of the text using the button shown on the Drawing
toolbar.
To add fancy text headings, you can use the WordArt button. Click the button
and then select your preferred WordArt style. You can then type your text to
create the heading.

Using AutoShapes
For a wider variety of shapes, including stars, block arrows and flowchart
symbols, select the AutoShapes menu. You can then click and drag on the
slide to draw your selected shape.

Selecting Objects
Before you can move, scale, delete or customise an object, you must select it.
Select an object by clicking it. Selection handles will be shown around it.
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Moving and Scaling Drawing Objects
Drawing objects can be moved and scaled in the same way as clip art. Click
and drag to move the image, or to scale, click one of the selection handles
and drag to the required size. To keep the object's original proportions, hold
down the [Shift] key as you drag the mouse.
Note: You can also move an object in small nudges by using the arrow keys
on your keyboard.

Deleting Objects
To delete an object, select it and then press the [Delete] key.

Changing the Fill and Line Colour
Once you have drawn a shape, you can change its fill colour using the Fill
Colour button or its line colour using the Line Colour buttons on the Drawing
toolbar. Make sure you have selected the shape you want to change and then
click the required button to make your choice.

Adding Text to an Object
Once you have drawn a shape, it is possible to add text to the shape. Simply
right-click the shape and choose Add Text from the Shortcut menu. You can
then type in the text and format it as you wish.
For example, if you have drawn a circle and then want to add text to it, rightclick the circle and choose the Add Text option.

Rotating and Flipping Objects
You can flip and rotate objects you have drawn by selecting the object and
then choosing the required option from the Draw menu.
If you select Free Rotate, you can drag the shape to the required angle. After
clicking the Free Rotate button, move the mouse pointer onto one of the
green selection handles and drag to rotate.
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Grouping and Ungrouping Objects
Using the Group feature, separate shapes can be grouped together to create
a single shape. This can be useful if you need to keep a collection of shapes
together to make them easy to move around or to ensure they are introduced
as a single item when you apply animation.
To group shapes, select all the objects you wish to group together, then select
the Group menu option from the Draw menu or right-click the selected
shapes and choose Group from the Shortcut menu.
Once you have grouped a shape, you can always ungroup it again should you
need to delete a part of the shape or change it.
You can also choose to Ungroup clip art images. This will convert them to
drawings which will give you full control of the picture, allowing you to delete
parts of the picture should you wish to.

Exercise 2: Adding Graphics to Slides
1 Create a new presentation based on your selected design template and
create four slides with the information shown below. If necessary, you can
search for the graphics by typing these words into the Search for clips
box in the clip gallery:
Slide 2: hoops
Slide 1:

Slide 3: goals

Slide 4: bottle

Title — Promotional Campaign for Alembic FC
Subtitle — Presented by Calypso Marketing

Slide 2:

Title — Campaign Objectives
Bullet points — National newspapers
National broadcast
Regional newspapers
Soccer magazines
Select a graphic with hoops.
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Slide 3:

Title — Strategy
Bullet points — National press release
Regional press release
Trade press release
Broadcast raids
Sampling
Select a graphic with goals.

Slide 4:

Title — Post Match Party
Select a graphic with a champagne bottle.

2 On slide 4, click the champagne bottle. If the Picture toolbar is not
automatically displayed, choose to display it using the View, Toolbars
menu option.
3 Using the buttons on the Picture toolbar, experiment with the brightness
buttons available on the Picture toolbar.
4 Crop the bottom of the bottle by clicking the Cropping button and then
dragging the bottom/middle selection handle upwards as illustrated below.
Your graphic may not be similar but the idea and concepts are the same.

Click this handle and drag upwards to remove part
of the picture.

5 While the champagne bottle is still selected, click the Recolour Picture
button and change the image so the various purple colours used are
substituted with another colour(s).
6 Save the presentation using the name Promotion in the Presentations
folder in your PersonalStuff folder.
7 Close the presentation.
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Copying and Moving Text and Objects
To copy or move text and objects, you can use the Cut, Copy and Paste
options available from the Edit menu.
The Cut menu option, or the Cut button shown on the Standard toolbar, is
used to remove the selected text/object and place it on the Windows
Clipboard. The Copy menu option, or the Copy button, is used to copy the
selected text/object to the Windows Clipboard. The Paste menu option, or the
Paste button, is used to insert the text/object stored on the Clipboard onto the
current slide.
Note: The keyboard shortcuts for the Cut, Copy and Paste menu options are
[Ctrl] X, [Ctrl] C and [Ctrl] V respectively.

The Office Clipboard
Since the Windows Clipboard is shared, each time you cut or copy information
in any application, any data already on the Clipboard is overwritten. However,
when working with the Microsoft Office applications, you can make use of the
Office Clipboard which can store up to 12 cut or copied items from different
applications simultaneously. Notice the Clipboard stores data from both Word
and PowerPoint. These items can be pasted into any Office file. Simply
position the cursor where you want the pasted information to appear and click
the item icon shown in the Office Clipboard. You will notice when you point to
an icon that a small description of what the icon represents is shown. You can
also choose to paste all items at once by clicking the Paste All button shown
at the top of the Clipboard.
To display the Office Clipboard, select the View, Toolbars menu option and
then choose the Clipboard option.

How to Use Drag-and-drop to Copy Text/Objects
1 Select the text/object that is to be copied.
2 Point to the selected text/object and hold down the [Ctrl] key.
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3 Holding down the [Ctrl] key, click and drag the selected text/object to the
required destination, then release the mouse button and then the [Ctrl]
key.

Adding Hyperlinks
When setting up your presentations, it is possible to attach a hyperlink to any
object or text. When a user clicks on a hyperlink, it can be set to:
♦ take them directly to another PowerPoint file or a specific web page on the
internet/intranet
♦ take them to another page in the presentation
♦ create a new mail message addressed to a specific recipient
♦ take them to another type of program like a spreadsheet, or word
document
♦ create a new blank presentation.
To add a hyperlink, select the text or object that the hyperlink will be attached
to then select the Insert, Hyperlink menu option or click the Insert Hyperlink
button on the Standard toolbar. You can also use the shortcut key
combination [Ctrl] K.
The Insert Hyperlink dialogue box will be displayed. In this illustration, an
existing file or a web page is to be linked to. If you choose a different option
from the Link to list at the left, some of the options in the rest of the dialogue
box will change to match.
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Before you give a presentation, you should always check for broken
hyperlinks and test hyperlinks to external destinations. A broken hyperlink is
one that has an invalid destination — when the hyperlink is clicked,
PowerPoint or the web browser displays an error. The cause might be as
simple as a URL that was mistyped, or a hyperlink to a destination that was
moved or deleted.

Adding Multimedia
Multimedia refers to objects such as sound and video. To add one of these
objects to a slide, you can use a slide layout with a placeholder or you can
use the Insert, Movies and Sounds menu option and choose the type and
name of the file you want to add. This can be from the Gallery or from another
existing file. PowerPoint calls these media clips.

Inserting Sound or Video
You can add music and sounds from files on your computer, a network or the
internet. You can also record your own sounds to add to a presentation, or
use music from a CD. If you take music from a CD you need to ensure that
you are not breaking any copyright that may exist on the music.
When you insert music or sounds on a slide, a sound icon that represents the
sound file appears. You can set the music or sound to start automatically
when the slide displays, start on a mouse-click, start automatically but with a
time delay, or play as part of an animation sequence.
Note: If you do not want the icon to be visible, you drag it off the slide and set
up the sound to play automatically.
Depending on your operating system, PowerPoint may not be able to support
a particular media type so you need to be aware that your feature may not be
available on all computers that are running your presentation.
You will need speakers and a sound card on your computer to play music and
sounds.
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By default, sounds are automatically linked to your file, rather than embedded
in it, if they are greater than 100 kb in size. You can change this default to be
more or less than 100 kb. When your presentation has linked files, you must
copy the linked files as well as the presentation if you are going to be giving
the presentation on another computer.
You can add music, songs, or sound effects that play:
♦ automatically when you display a particular slide
♦ when you click the sound icon on a particular slide
♦ over one or multiple slides.

How to Add Music, Songs or Sound Effects
1 Display the slide to which you want to add music or sound effects.
2 On the Insert menu, point to Movies and Sounds, and then do one of the
following:
♦ Click Sound from File, locate the folder that contains the file that you
want, and then double-click the file.
♦ Click Sound from Clip Organiser, scroll to find the clip that you want,
and then click it to add it to the slide.
3 When the dialogue message is displayed, do one of the following:

♦ To play the music or sound automatically when you go to the slide,
click Automatically.
♦ To play the music or sound only when you click the sound icon click
When Clicked.
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To adjust the settings for when the sound file stops, click the sound icon,
right-click, and then click Custom Animation.

In the Custom Animation task pane, click the arrow on the selected item in
the Custom Animation list, and then click Effect Options.
On the Effect tab, under Stop playing, do one of the following:
♦ To stop the sound file on mouse-click of this slide, select On click (the
default).
♦ To stop the sound file after this slide, select After current slide.
♦ To keep the sound file playing for several slides, select After, and then
set the total number of slides the file should play on.
You can also edit the sound properties.
1 Click on the sound icon.
2 Right-click and choose Edit Sound Object.
3 The following dialogue box will be displayed:
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If you click the Display options check box then the sound icon is not
displayed during the presentation. The bottom area gives information about
the sound object, the playing time and also if the file is linked or embedded in
the presentation.

Inserting a Video/Movie Clip
Video file formats such as AVI, QuickTime and MPEG, and file extensions
such as .avi, .mov, .qt, .mpg and .mpeg can be used in your presentation.
A typical video clip or movie might include a speaker talking — an executive,
for example — who is not able to be at the actual presentation. Or, you might
use a video clip to demonstrate some form of training.
An animated GIF file includes motion and has a .gif file extension. Though
these are not technically movies, animated GIFs contain multiple images
which stream to create an animation effect; they are often used to accent a
design or website. The clip library supplied by PowerPoint contains these
types of file.
The actions carried out are similar to those carried out previously when we
discussed inserting sound into your presentation.
To add the movie or animated GIF, insert it onto the specific slide using
commands on the Insert menu. There are several ways you can start it: have
it play automatically when the slide displays; click it with the mouse; or create
a timing for it so that it plays after a certain delay. It can also be part of an
animation sequence.
Although accessed through the Insert menu, movie files are automatically
linked to your presentation, rather than embedded inside it like pictures or
drawings.
Note: When your presentation has linked files, you must copy the linked files
as well as the presentation if you need to show the presentation on another
computer. As video clips are usually large files you should always copy these
files along with your presentation.
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How to Add Video/Movie Clips
1 Display the slide to which you want to add music or sound effects.
2 On the Insert menu, point to Movies and Sounds, and then do one of the
following:
♦ Click Movie from File, locate the folder that contains the file that you
want, and then double-click the file.
♦ Click Movie from Clip Organiser, scroll to find the clip that you want,
and then click it to add it to the slide.
3 When the dialogue message is displayed, do one of the following:

♦ To play the movie automatically when you go to the slide, click
Automatically.
♦ To play the movie when you click the clip, select When Clicked.
You can edit the movie properties:
1 Click on the clip area. (Note: This will appear as a black area.)
2 Right-click and choose Edit Movie Object.
3 The following dialogue box will be displayed:
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The bottom area gives information about the movie object, the playing time
and also where the file is located on your computer.

Working with Tables
Adding Tables
A table is made up of rows and columns. The point at which a row and a
column meet is called a cell. This arrangement makes it simple for you to lay
out information in a neat, easy-to-read format. You can then enhance the
appearance of the table to give the look you want by applying borders and
shading, as well as formatting the presentation of the text.
1 Apply a slide layout that uses a table layout or select the Insert, Table
menu option.
2 If necessary, double-click the table placeholder and you will be prompted
to enter the number of rows and columns required. This box will also be
displayed if you use the Insert, Table menu option.
3 Enter the number of columns and rows you want your table to have and
then click OK.
4 The table will appear on the slide and you can enter the information that’s
to be shown in the table.

Moving Around a Table
You can move the insertion point around a table by clicking the cell using the
[Tab] key to move to the next cell or [Shift] [Tab] to move to the previous
cell.

Entering and Editing Table Text
When you want to enter text into the table, move the insertion point to the cell
then type the text. As you type, the text will wrap onto a new line when it
reaches the right edge of the cell. If you want to edit the text in your table,
position the insertion point in the cell then edit the text as usual.
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If you press [Tab] in the last cell in the last row of the table, a new row of cells
will be added to the table.

Adjusting Column Widths
1 Ensure there are no cells selected.
2 Move the mouse onto the right gridline of the column you want to resize.

Selecting Cells
Once you have created a table you can format it by applying borders, shading
and other formatting options. But first you must select the part(s) of the table
to be formatted.
You can select information in a table by dragging over the required cells using
the mouse. You can also select entire columns by moving the mouse above
the column you wish to select. Clicking once will then select the entire column.
Clicking and dragging will select multiple columns.

The Tables and Borders Toolbar
When you are working on your table, you will see the Tables and Borders
toolbar displayed on screen. Using this toolbar you can apply formatting to
your table and use the options available from the Table menu to select parts
of your table or insert columns and rows.
Before selecting options from the Tables and Borders toolbar, first select the
part of the table you want the formatting to apply to. For example, if you wish
to apply background shading to specific cells, first select the cells and then
choose the colour you want using the Fill Colour button.

Presentations Student Workbook — Beginner/Intermediate/Advanced

50

PC Passport Support Materials

Working with Master Slides
PowerPoint templates provide you with a choice of standard presentation
formats that can be used for as many different presentations as required. If,
however, you would like to customise the layout of the slides in a particular
presentation, by incorporating a college or school logo or company name on
each slide, for example, you can do so by editing the Slide Master. Changes
made to the Slide Master affect only the presentation that is edited.
Any object that is to appear on every slide in a presentation is specified on the
Slide Master. The format to be applied to any text object(s) on the slides is
also specified here. Therefore, if you want to add an object such as your
name to every slide, you would add it to the Slide Master. Likewise, if you
wanted to change the format of the slide titles, applying the changes to the
Slide Master would mean that you’d only have to do it once. You can use a
pre-defined template, apply fonts and font styles to the Slide Master and these
are used in all the slides.
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However, you should note that if you format text on an individual slide, it
would no longer follow the Slide Master that it's based on, and so would not
be affected by changes made to the Slide Master.
Earlier you used the View, Header and Footer menu option to add your
name to the footer so that you could recognise your printouts. When you did
this, your name was added to the footer area on the master slide.
You can edit the Slide Master at any time. Just select the View, Master, Slide
Master menu option and change or format the master slide like any other.
Note: If you apply a different template to your presentation after you have
made changes to the Slide Master, the changes, including any background
items you have added, will be lost (a background item is any object on the
Slide Master other than the title and text placeholder).

Changing the Presentation Colour Scheme
The colour scheme originally applied to the slides in your presentation will
depend on the template you've used. You can choose to apply a different
colour scheme either to all the slides or just to individual slides. This would
allow you to use different colour schemes for different sections of your
presentation.

How to Change the Colour Scheme
1 Select the slide that you want to change the colour scheme of.
2 Select the Format, Slide Colour Scheme menu option. Alternatively,
right-click the slide, and then choose the Slide Colour Scheme option.
The Colour Scheme dialogue box will be displayed. There are two
property sheets: Standard and Custom.
3 From the Standard, select one of the preset colour schemes illustrated by
clicking the one you want.
4 If necessary, click the Custom tab to display the Custom property sheet.
From here you can define your own choice of colours.
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Click the slide element that you want to change the colour of, then click the
Change Colour button.
5 Select the new colour from the Standard or Custom property sheets then
click OK.
6 Once you've assigned the colours you want for each element, click the
Add as Standard Scheme button to add the new colour scheme to those
available from the Standard property sheet.
7 Click the Apply button to apply the new colour scheme to the selected
slide only, otherwise click the Apply to All button.

Adding Slide Show Effects
Some of the effects you can add to slides will only be used when you run a
slide show. These include transitions, animation effects and hidden slides.
Although transitions and animations can enhance your slide show, you should
be careful not to use too many — you want your audience to remember and
perhaps act on the content of your presentation rather than be distracted by
the presentation itself. But remember most animations will not give the same
visual impact when you print out your slides; none of the animation will display
on printed paper.
The best view to use to add these effects is Slide Sorter view.

Adding Slide Transitions
A slide transition dictates how a slide will come onto the screen during a slide
show. The text might fly in from the left, or drop down from the top.
PowerPoint has many different transition effects that you can add to your
slides to enhance your slide show.
To add a transition, select the required slide and then choose a transition
effect from the Transition drop-down list. Note: You can also set a transition
by clicking the Slide Transition button shown at the far left of the Slide
Sorter toolbar. Using this button you will be given further choices, including
the options for the speed of the transition and for adding a sound effect.
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Adding Slide Animation
Adding animation enables you to specify which type of effect you would like to
use to introduce each element displayed on a slide, eg how the text will
appear on the slide. For example, if you have a list of bullet points, you may
wish these bullet points to be introduced one at a time when you click the
mouse. This can be achieved by applying an animation effect. To add
animation to a slide, select the slide and then choose an animation effect from
the drop-down list.
Remember slide transition is about how the slide will appear on the screen
and animation is about how the slide text will look when it is displayed on the
slide.

Custom Animation
Custom animation will allow you to produce slides that can be visually exciting
by displaying it in ways that have impact for the person viewing the
presentation. Custom animations can be applied to items on a slide like clip
art, in a placeholder, or to a paragraph (which includes single bullets or list
items). You could use entrance, emphasis or exit options for specific text. You
can apply more than one animation to an item, eg you can make a bullet item
fly in and then fly out.
Most animation options include associated effects to choose from:
♦ options for playing a sound with the animation
♦ text animations usually let you apply the effect by letter, word, or
paragraph (such as having a title fly in a word at a time instead of all at
once).
You can preview the animation of your text and objects for one slide or for the
whole presentation.

Hiding Slides
It is possible to hide a slide from your audience when running the slide show.
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Having a slide marked as hidden gives you an option as to whether you will
actually display the hidden slide during your presentation or not. For example,
if when running the presentation you find you are running ahead of time, you
could choose to display one or two hidden slides to stretch the length of your
presentation.
To hide a slide, select the slide you wish to have in reserve and then click the
Hide Slide button or select the Slide Show, Hide Slide menu option.
This slide will not be displayed during the slide show unless you press H just
before this slide is due to be displayed. Only then will the slide be included in
the slide shown presentation.

Creating a Summary Slide
PowerPoint can automatically create a summary slide that will comprise the
headings from a number of slides that you select.
To create a summary slide, select the slides from which the summary slide is
to be created and then click the Summary Slide button. The new summary
slide will then be created and inserted in front of the selected slides.

Running a Slide Show
Earlier in the course you used the View, Slide Show menu option to run
through the entire presentation using the full screen, one slide at a time. If you
want to run a slide show starting on a specific slide, or want to set up the slide
show to loop continuously, you can use the Set Up Show options before
using View, Slide Show.

How to Set Up a Slide Show
1 Select the Slide Show, Set Up Show menu option.
The Set Up Show dialogue box will be displayed.
2 In the Show type group, choose the option button that corresponds to the
type of show you want to run.
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Presented by a speaker (full screen): This is the standard full-screen
show that uses all the options shown in this section of the Unit. This is the
default type of show.
Browsed by an individual (window): If the presentation will be run on a
computer in a public place where anyone who is interested can view it at
their leisure, choose this option. The presentation will be run in a window
rather than full-screen, and simplified menus and toolbar buttons are made
available so that the user doesn’t have to know how PowerPoint works in
detail.
Browsed at a kiosk (full screen): This is a self-running slide show. The
user can advance the show and click hyperlinks but they can’t make any
changes to the presentation. The slide show restarts after five minutes of
inactivity.
3 Also in the Show type group, tick the appropriate boxes:
Loop continuously until ‘Esc’: Tick this option to return to the first slide
in the show when the last one disappears. Otherwise, the show will end
after the last slide.
Show without narrations: If you’ve added voice narrations to any of your
slides, ensure that this box is not ticked if you want them to be heard.
Show without animations: If you want to show the slide show without
including the animations that you’ve applied, tick this option.
4 If you chose the Browsed by an individual (window) option button as the
type of show you want, tick the Show scrollbar box to display a vertical
scrollbar.
5 In the Slides group, select the range of slides you want to include in the
slide show.
All: Select this option button to show all slides.
From: Select this option button and specify the range of slides to be
shown in the From and To text boxes.
Custom show: If you have created any custom shows and want to run
one of these, select this option and choose the custom show from the
drop-down list.
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6 Choose how you want the slide show to progress in the Advance slides
group:
Manually: This option will allow the user to choose when to move to the
next slide.
Using timings (if present): This option will advance the slide show after
the time specified for each individual slide has elapsed. This option is
available only if you have preset timings for each slide.
7 Click the Pen colour button to select the colour of the pen to be used to
annotate slides during the slide show.
8 Click the Projector Wizard button if you want PowerPoint to help you
connect to a multimedia projector.
9 Click OK.

Rehearsing Timings
It is not always convenient to manually advance the slide show that you are
presenting; sometimes you’ll want to automate the progress of the show.
PowerPoint gives you the choice of allowing the computer to advance the
slide show using times that you set during a rehearsal.
1 Select the Slide Show, Rehearse Timings menu option.
Note: If you are in Slide Sorter view you can run a rehearsal by click the
Rehearse Timings button shown on the Slide Sorter toolbar.
The first slide is displayed along with the Rehearsal dialogue box. This
box contains a timer that records the time the current slide is on the
screen, the time taken so far for all slides that have been shown, and
pause and advance buttons. The Repeat button can be used to cancel the
time for the current slide and start over again.
2 Move through the presentation, leaving each slide on screen for the length
of time it should be displayed during the actual presentation.
The display time for each slide will be recorded and the Timings dialogue
box will be displayed at the end of the slide show, asking you whether you
want to keep the timings or not.
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3 If you want to store the times for each slide then click the Yes button and
you will be returned to PowerPoint. If you wish to disregard the times then
click the No button.

Running a Slide Show
When you have created the slides and specified the settings for the slide
show, you're ready to run the show. You can do this by selecting the View,
Slide Show menu option, the Slide Show, View Show menu option or by
clicking the Slide Show button shown near the bottom left corner of the
PowerPoint window.

Running a Timed Slide Show
Select the Slide Show, Set Up Show menu option, select the Using timings,
if present option button then click OK. Note: If you run the show using the
Slide Show button, the show will begin with the current slide.

The Slide Show Screen
Options for working with the slide show can be accessed via the slide show’s
shortcut menu which you can display by right-clicking during the show, or by
clicking the icon that appears at the bottom left of the slide show screen when
you move the mouse. Amongst other things, these options allow you to move
from slide to slide and to switch between the pointer and the pen used for
annotating slides.

Using the Mouse and Keyboard During the Slide Show
As well as using the mouse to display the shortcut menu during a slide show,
you can use it to move through the slide show one slide at a time by clicking
the left mouse button.
This is a list of keyboard menu options that are available during a slide show.
N, [Spacebar] or [Page Down]

Advance to next slide

P, [Backspace] or [Page Up]

Return to previous slide

Arrow keys (All)

Navigate forward or backwards to any slide
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Slide Number [Enter]

Go to slide number

B

Hide the current slide by turning the screen black

W

Hide the current slide by turning the screen white

A

Show/hide pointer

S

Stop/restart timed slide show

[Esc]

End show

E

Erase screen annotations

T

Record the new rehearsal time for the current slide

O

Use original rehearsal time for the current slide

H

Advance to hidden slide

[Ctrl] A

Change to mouse pointer

[Ctrl] P

Change to pen tool

Annotating Slides
While the slide show is running, you can change the mouse pointer to a pen
so that you can draw attention to specific parts of a slide. These are called
annotations. Press [Ctrl] P and the mouse pointer changes to the pen pointer.
Once you have changed to the pen pointer, you can draw on the slide by
clicking and dragging. These annotations are not permanent though — when
you move to another slide, they are removed. If you want to remove the
annotations without moving to another slide, right-click and choose Screen,
Erase Pen or simply press E.
Note: You can change the colour of the pen tool by selecting Pointer
Options, Pen Colour option from the slide show’s shortcut menu.

Presentation Hardware
In addition to the hardware that you use every day, there are a number of
components that are used specifically when running an electronic
presentation (in PowerPoint, this is called a slide show). These include the
following.
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Overhead Projector
An overhead projector (sometimes called an OHP) projects the image that’s
placed on its flat surface onto a projection screen or other flat surface. The
image to be displayed is usually printed or written/drawn onto a transparent
film called acetate.

Multimedia Projector
You may wish to present information to many people at once without printing.
A useful device for this is the multimedia projector, also known as data
projector. This can be connected to the computer and used to display
presentations or demonstrate a particular procedure as a projected image.
One of the biggest advantages of using a multimedia projector rather than an
OHP is the fact that you can show motion in your presentation.
There are many presentation programs that lend themselves to this device;
Microsoft PowerPoint and Lotus Freelance Graphics are examples of this type
of program. It is important that regular maintenance is carried out to ensure
your projector is well maintained, for example check the bulb (a typical bulb
lasts for about 2,000 hours), dust filters, and make sure vents are clear and
power supply cables are in good condition. Remember to power down the
projector to allow the bulb to cool before turning off the power supply — this
will help preserve the bulb.

Projection Screen
When you use either an overhead or a multimedia projector, you need a
surface on which to project its images. Traditionally, this surface has been a
projection screen which can be portable or perhaps mounted on the ceiling to
be lowered when needed. Nowadays, whiteboards are also commonly used
as projection screens, although any surface that displays the presentation
clearly and legibly to all parts of the audience is acceptable. To ensure small
images can be seen on the projection screen, it may be necessary to move
the projector further back, to enlarge the image on the projection screen.
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Remote Mouse
Unless you intend to deliver your entire presentation stationed at the
computer, you will need some method of moving through the slides in your
presentation as you go along. A remote mouse can allow you to do this. This
is a mouse that is not directly connected to your computer. Instead, it has a
wireless infra-red connection to another device that is connected to the
computer.
Some multimedia projectors are supplied along with a handheld device that
looks a bit like a TV remote controller and serves as a mouse as well as
controller for the functioning of the projector. These controllers have a
maximum operating range, so be careful not to be too far away from the
hardware it’s controlling, and if it’s an infra-red device, be sure there is a clear
line between the mouse and the connection device.

Sound
Most modern PC software includes sound as a package of warning and alert
sounds for programs, or as music or speech. To make these sounds, the PC
needs to have a sound card inside the system unit. So that your computer can
communicate with the sound card properly and vice versa, you need to have
the correct driver installed for the card (the driver is a program that controls
the sound card). In fact, if you don’t have the most up-to-date driver for your
sound card, you might find that the card doesn’t work properly, causing
problems with the sounds you’ve added to your presentation.
Your PC may have a built-in speaker; however, speakers are needed if all
sounds are to be heard. Some speakers come attached to the monitor, and
some are entirely separate. Either way, these speakers connect to your sound
card and are useful for realising the full potential of the internet, your
computer, and your software. Speakers are also useful for allowing the
visually impaired to operate computers. Using a sophisticated program called
a speech synthesiser; the computer can talk to the user and tell them what is
happening on-screen.

Presentations Student Workbook — Beginner/Intermediate/Advanced

61

PC Passport Support Materials

Preparation
It’s always a good idea before running a presentation to prepare the
equipment and other resources you’ll use, such as the temperature and
lighting in the room and the positioning of the furniture, as well as your content
and delivery style. You should also test that the equipment is working the way
that you would expect and that your presentation not only runs on the PC
you’ll use to deliver it, but that it looks and works the same as it did on the PC
you used to create it.

Overhead Projector
If you use an overhead projector, there will be no connection between it and
the computer equipment and you will use a set of slides printed on acetate
film.
When preparing for your presentation, you should:
♦ check the power to the projector
♦ make sure that the projector platform and lens are clean and dust-free
♦ check that the bulb is working and that you have a spare (and that you
know how to change it if you need to)
♦ adjust the height of the projector lens so that the projected image is at the
height and position you want it
♦ make sure the projector is focused properly so that your projected slide
images are clear and legible from all audience positions.
You should also take note of which way up and round the slides should be
placed on the OHP platform so that they’re projected the right way up. Finally,
when working with either type of projector, you should switch off the power
when you’re finished to preserve the bulb and conserve power.

Multimedia Projector
A multimedia projector will connect to your computer via a video cable that
plugs into both the computer and the projector. The cable may be fixed at the
projector end or it may be detached. Make sure you know where on the
projector and the computer this cable plugs in.
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As with the OHP, you should check the power to the projector as well as the
clarity and position of the projected image. In addition, you should practise
beforehand to ensure you know how to operate the projector.

Projection Screen or Surface
Often a projection screen will be used along with either an overhead projector
or a multimedia projector, although these days images are often projected
onto a whiteboard or a plain, light-coloured wall. Whichever surface you
intend to use, you should check that the projected images are clear and
legible and can be seen from all positions where your audience will be
positioned, and that there are no marks on the surface that will mar your
presentation. You should also consider the room lighting that best suits your
needs.

Remote Mouse
If using a remote mouse, make sure you are familiar with how it works and
practise so that your presentation is smooth without any pauses to figure out
the equipment. It’s also a good idea to be familiar with alternative methods of
moving from slide to slide (eg using the computer keyboard) just in case
there’s an issue with the mouse during your presentation. You will also want
to check prior to your presentation that the batteries in the remote mouse are
charged.
Before any presentation, where possible you should have a ‘dress rehearsal’
using all the equipment you intend to use on the day. This will make sure
there will be no surprises for you when the audience is there and so you can
concentrate on your delivery, confident that everything else is in order.
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Exercise 3: Running a Presentation
1 What hardware would you need to run a slide show from your computer?
___________________________________________________________
___________________________________________________________

2 If you’re using a multimedia projector but no image is displayed on your
projection surface what could be wrong?
___________________________________________________________
___________________________________________________________

3 What would you check if your remote mouse wasn’t working?
___________________________________________________________
___________________________________________________________

4 Your presentation contains sound clips, but when you rehearse using the
hardware that you’ll use on the day, no sound can be heard. What could
the problem be?
___________________________________________________________
___________________________________________________________

5 The person who promised you an overhead projector and screen has only
dropped off the projector. Can you deliver the presentation anyway? If so,
how can you get round this problem?
___________________________________________________________
___________________________________________________________
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Planning, Preparing and Delivering a
Presentation
Planning Your Presentation
There are some questions you should ask yourself about your presentation,
its goals and your audience before you start to create it. For example:
♦ Objective
What is the objective of the presentation?
What are you trying to achieve through this presentation — do you want
the audience to know something, understand something or do something?
♦ Audience
Who are your audience?
How does the subject of your presentation relate to your audience?
What do they know about the subject?
What do they need to know?
Information you reference or quote is from reliable sources, for example
government website, encyclopaedias, etc
♦ Timings
How much time is available for your presentation? Look at the material you
have in relation to the amount of time.
♦ Venue
Where will you deliver this presentation?
Do you know about the venue’s size, seating arrangements, etc?
♦ Equipment
Do you intend to use visual aids? If so, what equipment will you need to
project your images, eg computer, overhead projector, video or a flipchart?
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Structure
All presentations should have a beginning, middle and an end. A good way to
summarise what each of these should contain is this:
♦ Beginning — tell them what you're going to tell them (a brief introduction
to the topic)
♦ Middle — tell them (the body of your information)
♦ End — tell them what you've told them (a summary of the topic)

Beginning
A good opening is essential. This will help you establish a relationship with
your audience, relax them and help you to gain their co-operation.
Try to make a clear statement about the objective of the presentation — avoid
diving straight in. You need to let the audience settle down and tune into your
voice and the impression you make. The beginning is all about gaining your
audience’s attention.
Middle
Having gained their attention, it’s now about building bridges to take the
audience logically from one section to the next. Try to involve your audience.
A presentation is a form of communication and the best form of
communication is two-way.
End
Keep it short. A brief, well-delivered conclusion is much more effective.
Summarise and pause, allowing for individual points to have an impact.

Key Point
More than anything else, the success of your presentation depends on your
understanding the audience’s point of view. The degree to which this is true
depends on the topic and objective of your presentation. If, for example, you
are delivering a presentation about a change of practice in a business
environment, it will be more important to get the audience on your side than if
you were delivering a presentation about your favourite music to your
classmates.
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Each member of the audience has a thinking sequence something like this:
1 I am important and want to be respected.
2 Consider my needs.
3 Will your ideas help me?
4 What are the facts?
5 What are the snags?
6 What shall I do?
7 I approve.
To address this, you should try to:
♦ structure your presentation around the listener’s point of view
♦ gain their attention and retain interest
♦ convince them of the value of your presentation
♦ answer their objections confidently and deal with any doubts
♦ lead them to a conclusion in your favour.

Preparing for Your Presentation
The preparation for delivering your presentation will vary according to how
you plan to deliver it. General guidelines for each standard delivery method
are included here.

Equipment
If you plan to deliver your presentation via a slide show, you must make sure
that the computer and projector are in working order and that all the
connections are securely made. For example, check that the projector does
not overheat, eg because of books blocking the fan vent, or a clogged dust
filter. You should also check that any remote controller such as a remote
mouse is in working order and you know how to use it.
It’s always a good idea to run through your presentation using all the
equipment you’ll use on the day so that you can be comfortable with it. If your
presentation includes sound, be sure that speakers are available.
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If you plan to deliver your presentation via an overhead projector, you need to
check that you have your slides printed clearly and that the projector is
working and you know how to focus it. You should consider numbering your
slides to make sure that you keep them in the correct order.
In either case, you should check that the equipment is where it should be or
will be there when you need it. Make sure you have a clear projection surface.
It's good practice to familiarise yourself with the connections and operating
procedures for all equipment.

Environment
The area in which you’ll deliver your presentation must be suitable for the
purpose. You should check:
♦ Temperature
The area should be neither too hot nor too cold — the audience should be
comfortable but not sleepy.
♦ Lighting
Be sure that the audience can read your slides clearly.
♦ Seating arrangements
Make sure there are no obstructions between the audience and the
projection surface.
♦ Noise
If possible, make sure that there is no outside noise to distract your
audience.
In addition to the above, be sure you know where the controls are and how
they work.

Your Presentation
If you are copying a presentation to another computer that you’ll use to deliver
it (or unpacking one using the Pack and Go Wizard), do this with enough time
to run through the presentation to check that it looks and sounds the same on
the new computer as it did when you created it. If you have time, try to have a
full rehearsal, perhaps with a friend sitting in place of the audience to give you
tips.
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Handouts
Be sure that any handouts you’ve prepared for the audience have been
printed and will available to you on the day.
Be sure you can see the presentation. The text should be large, at least size
42 point, colours should be plain (black on white is best) and easy to see —
this includes background images, watermarks or colour schemes.

Creating Speaker Notes
To help you to deliver your presentation more effectively, PowerPoint allows
you to create speaker notes. These can be typed into the Notes pane when
viewing your presentation in Normal view.
Notes can be typed in relation to each slide, if necessary, and can be printed
to support you while delivering the presentation.

Delivering Your Presentation
Presentation Skills
The area of presentation skills is a very wide one. Here is a list of some things
to think about when preparing to deliver a presentation to an audience. Some
of these might be useful for helping you to deal with any nerves you may have
about public speaking.
Be Aware of
♦ Your visual impact: your clothes, expressions and gestures.
♦ Your tone of voice: vary your pitch, as a constant tone will eventually turn
off the audience.
Visual Impact
The audience will react to their first sight of you. The way you are dressed,
your facial expression and your gestures should be appropriate to the content
of the presentation, the type of audience you’re delivering to and their —
changing — mood. An audience has greater confidence in a speaker who
looks at them.
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Tips
♦ Your tone of voice should match the occasion. Variety of pitch is more
important in presentations than in ordinary conversation.
♦ Start preparing your presentation well in advance.
♦ Identify why you are speaking and the result you want.
♦ Find out as much as you can about your audience, such as age and their
current knowledge of the subject.
♦ Don’t try to write the presentation in one sitting. Keep a notebook by you to
jot down ideas as they come.
♦ Don’t try to impress with big words or complex theories that aren’t
appropriate — KISS (Keep It Simple Stupid).
♦ Pick two or three points and illustrate them with examples. Too many
points and your audience won't remember them.
♦ Keep a file of humorous notes and stories that you can use when
appropriate.
♦ Avoid using jargon, abbreviations and statistics. If possible, use visual aids
to present and reinforce numbers.
♦ Be precise — make sure your message is clear.
♦ Avoid clichés.
♦ Write bullet points on a white card. Try not to read a script — it will sound
stilted and unnatural.
♦ Rehearse aloud several times — familiarity breeds confidence. Use a tape
recorder or a friend to get feedback.
♦ Make your voice interesting by varying your pitch, volume and speed. Use
pauses to help emphasise key points and avoid using filler words such as
‘um’, ‘you know’ and ‘I mean’.
♦ Remember that nerves often make you speak high and fast, so practise
speaking a little slower and deeper.
♦ Wear comfortable clothes and footwear.
♦ Empty your pockets so you are not tempted to play with the contents.
Avoid putting your hands in your pockets and do not wear any distracting
items, such as an outrageous tie or jewellery that catches the light.
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♦ Make sure that your listeners can see your face and that your hair is not
falling into your eyes.
♦ Think of everyone in the audience as a friend who wants you to be
successful.
♦ Walk slowly to the speaking spot. Look at the audience (all of them), smile
and take a couple of deep breaths before you begin.
♦ Maintain eye contact with everyone and avoid looking at the most senior or
friendly person in the audience.
♦ Smile! Remember that the audience is more interested in what you have to
say than in you.

Problem Solving
Even after all your planning and preparation, you may have an issue or two to
deal with during the presentation. For example, what would you do if the
projection screen suddenly went blank — or if the computer crashed?
The main thing to remember is to stay calm — these things happen. Next, use
your knowledge of the equipment to try to work out what’s wrong and fix it.
Once you’ve fixed it, restart the presentation at the point where the problem
occurred. As long as you are composed the audience will trust you to fix the
problem and continue.
Here are some problems you might encounter and suggestions for how to
deal with them:
Problem

Possible Reason

Possible Resolution

The
screen’s
blank

If appropriate, is the projector
connected properly to the
computer?

Check the connections to see that
they’re secure.

Is the power to the projector and
the computer connected?

Check the power supply connection
to see that it is secure.

Has the power supply failed? Is
the dust filter clogged? Or is the
air vent blocked?

Check other electrical devices in
the area.

Does the projector need a new
bulb? It runs out after about
2,000 hours.

Replace bulb and check again.
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The remote
mouse isn’t
working

The slide
show won’t
progress

Does the mouse require a clear
path to its connecting device?
Does it have a clear path?

Make sure the mouse has a clear
path to the device that connects it
to the computer.

Is the connecting device
connected to the computer?

Check the connection to see that
it’s secure.

Do the batteries in the mouse
need to be replaced?

Replace the batteries and check
again.

Has PowerPoint crashed — can
you stop the show and restart it?

Try stopping and restarting. If this
doesn’t work, close any programs
you can and reboot the computer.

Has the computer crashed —
can you run other programs?

Try running another program. If this
doesn’t work, close any programs
you can and reboot the computer.

The slide
Is the projector out of focus?
image isn’t
clear on the
Is the projection surface clean?
projection
surface
Is there too much light in the
room?
You can’t
hear the
sounds on
the slides

Adjust the focus setting on the
projector.
Clean the projection surface or use
another one.
Dim the lights a little.

Are there speakers attached to
the computer?

Check the connection to see that
the speakers are attached.

Are the speakers switched on?

Check that the speakers are
switched on.

Is the power supply connected
to the speakers?

Check that the power supply is
connected to the speakers.

Is the volume high enough?

Turn up the volume and check
again.

Web Presentations
You can save a presentation as a web page in HTML (Hypertext Markup
Language) format with the extension .htm. HTML is a markup language of
tags which determine how text and graphics are displayed in a browser.
The Save as Web Page command creates a web page from a presentation,
giving the presentation a navigation frame down the left side of the page.
You can choose to save the graphics in a presentation in PNG (Portable
Networks Graphics) format. PNG graphic files are smaller, so you can save
and download them faster. However, not all browsers support PNG format.
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With the web toolbar, you can access the internet using common Microsoft
Internet Explorer commands. It is important that when using graphics, video or
sound in your web presentation you reduce the resolution of the picture,
compress the pictures and discard any extra information after resizing — this
will ensure your presentation runs efficiently and there is little time delay when
viewing these elements of your presentation.

Online Collaboration
If your computer is on a network or if you have access to the internet, you can
give a slide show on any other computer on the network by using
PowerPoint’s online broadcasting feature. You can broadcast a presentation,
including video and audio, over the web. You can use broadcasting for a
company meeting, presenting to remote groups, or holding a team meeting
whose participants are at several locations. Be sure to have the necessary
additional equipment that participants might need (like a webcam or video
camera, microphone, headphones) to enable members to contribute to the
presentation.
By using Microsoft Outlook or any other e-mail program, you schedule the
broadcast just like any other meeting. The presentation is saved in HTML
format, so all that your audience needs in order to see the presentation is
Microsoft Internet Explorer 5.0 or later. The broadcast can be recorded and
saved on a web server where it's available for playback at any time.
You will need to specify the directory on your network in which you want to
store the presentation.
When you set up an online broadcast, PowerPoint creates a lobby page. This
page appears on the server before the broadcast starts. It contains audience
information about the broadcast, such as the person giving the presentation,
the date and time of the presentation.

Presentations on the Web or Intranet
You can design your presentation specifically for the World Wide Web or
intranet by publishing it as a web page.
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To publish a presentation means to place a copy of the presentation in HTML
format on the web. You can publish copies of the same presentation to
different locations. You can publish a complete presentation, a custom show,
a single slide, or a range of slides. Because navigation is a critical element in
a presentation, PowerPoint presentations in HTML format include a link bar
that you can use to move through the slides by using the outline pane.
Speaker notes are also visible to all viewers in a presentation published to the
web, so you can use that feature like a caption.

Collaborative Meetings
Using the Microsoft NetMeeting program with PowerPoint allows you to share
a presentation and exchange information with people at different sites in real
time as if everyone were in the same room. In a NetMeeting conference, you
can share programs and documents, send text messages in Chat, transfer
files, and work on the Whiteboard.
By collaborating, participants can take control of the presentation to review
and edit its contents. During the meeting, only one person can control the
presentation at a time, but multiple users can work in Chat or on the
Whiteboard simultaneously if collaboration is turned on.

Reviewing
Asking others to review and comment on your presentation can assist you in
perfecting the presentation before it is final. You or your reviewers can insert
comments, which are notes about text or other parts of the presentation.
Once comments are added to a presentation, you can edit or delete them,
and you can choose to show or hide them. You can add, edit or delete
comments in a presentation in two ways: you can use commands on the
Insert menu; or you can use functions on the Reviewing toolbar.
The Revisions Pane is used to view the comments made by reviewers in
each slide, as illustrated in the following image.
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Once you have created a presentation, you want to maintain its integrity. At
times, you may want the information in the presentation to be used but not
changed. For example, you can set a Read Only option for a presentation that
must be distributed and read, but not changed. You may want only specific
people to view the presentation. The password and other security options can
be used to protect the integrity of a presentation as it moves from one person
to another.
When you set a password, take a moment to write it down. If you lose or
forget the password for a protected presentation, you will not be able to open
it. To open a protected presentation, you need to enter the password in the
exact same way that it was set, which includes spaces, symbols, and
uppercase and lowercase characters.
You can set the password to prevent users from modifying the presentation —
if they do not know the password, they cannot make changes to the
presentation.
When you add a digital signature to your file, you can sign either a file or a
macro project. Sign a file when you are working with an unconverted
PowerPoint presentation; sign a macro project when you are working with a
presentation that has been converted to a web page. A digital signature works
as an electronic, secure stamp of authentication on a document.
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When you apply your digital signature to a document, you verify the contents
of the file and confirm that the file has not changed since you attached the
signature. If someone modifies the file, the digital signature is removed.
When you send the presentation for review using the Mail Recipient (for
Review) command, the message includes the text Please review the
attached document.
The markup feature is used to edit a presentation sent for review. Each
change made is marked with a call-out box that contains the reviewer’s name,
initials, the date, and the details of the actual comment or change. These callouts show changes in details without obscuring the presentation or affecting
its layout. They also give you a more visible view of the changes that have
been made.
As you review the comments and changes, you can accept or reject them one
at a time or all at once. When you accept a change, PowerPoint deletes the
Markup text or inserts the text it contains into the presentation, as appropriate.
The following table describes the options available on the Reviewing toolbar.
Name

Description

Markup

Allows you to track changes made to your presentation by
using call-outs within the presentation.

Reviewers

Allows you to view changes by specific reviewers or all
reviewers.

Previous Item

Allows you to move to the previous comment or tracked
change.

Next Item

Allows you to move to the next comment or tracked change.

Apply

Allows you to apply a change in a presentation, all changes to a
slide, or all changes to the presentation.

Unapply

Allows you to unapply a change in a presentation, all changes
to a slide, or all changes to the presentation.

Insert Comment

Allows you to insert a comment into a presentation.

Edit Comment

Allows you to edit a comment within a presentation.

Delete Comment/
Marker

Allows you to delete a comment or marker within a presentation
or to delete all comments or markers in a presentation.

Revisions Pane

Allows you to show or hide the Revisions pane.
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Exercise 4: Using a Presentation to Convey
Information
1 Load PowerPoint and choose to create a new presentation using the
AutoContent Wizard. Note: If PowerPoint is already running, select the
File, New menu option and choose AutoContent Wizard in the General
tab to start the wizard.
2 When you select OK, the AutoContent Wizard starts. Follow the
instructions below to create a new presentation that will convey bad news
to the audience.
♦ Read the information on the first screen and then click Next to begin
working through the selection process.
♦ Click the General button then choose the heading Communicating
Bad News.
♦ Click Next and then select the On-screen presentation option.
♦ Click Next and enter the following presentation title:
Company Restructuring
♦ Click Next and then Finish.
A presentation based on the Communicating Bad News wizard is
created and displayed. This presentation has seven slides with text on
each suggesting what your own text should say.
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3 Edit the content of the first five slides to read as follows. You can do this
either on the slides themselves or by editing the text in the Outline pane
shown here.

4 In the Outline pane, position your insertion point after the word
performance at the end of slide five and insert a new slide by clicking the
New Slide button.
5 Select a bulleted list slide layout and then edit the rest of the presentation
information as shown below.
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6 Follow the instructions below to move slide number 6 so it is positioned
after slide number 3.
Point to the slide icon for slide 6 and click once to select the entire slide.
Move the mouse pointer to any part of the highlighted area then click and
drag the slide upwards.
As you do this a horizontal line shows where the slide will be placed.
Once the horizontal line is shown immediately above slide 4 (as shown in
the illustration), release the mouse button to place the Strategic
Restructuring slide there.

2 … here, then
release the
mouse.

1 Click here
and drag to …

7 Try double-clicking a few of the slide icons displayed to the left of each
slide heading to hide the slide detail. Double-click these slide icons again
to redisplay the detail for all slides.
8 Save the presentation in the Presentations folder in your PersonalStuff
folder. Call it Company Restructuring.
9 Print handouts (four per page) and then close the presentation.
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Macros
Instead of performing a long set of commands to perform a task, you can
automate and simplify the process by creating a macro, which is a recorded
series or sequence of commands (keystrokes and instructions) that are
treated as a single command. For example, suppose your company uses a
special format and design for any tables that you insert in your presentation.
Instead of inserting a table, adding shading and borders, applying different
fonts to column and row headings, and then adjusting the line spacing, you
can create a macro to perform all these steps and save yourself a great deal
of time and effort.
You can use macros to automate many tasks, such as creating and inserting
AutoText, formatting text, creating tables, or turning command options on and
off.
1 To create a new macro in the Tools menu click Macros, Record Macro.
The Record Macro dialogue box is shown.
2 Give the macro a name and click OK — a small record button icon
appears for you to record the keystrokes you want to include in your new
macro. When finished, click Stop recording.
You can run a macro from the list of macros in the Macros dialogue box, or
you can assign the macro to a toolbar, menu item or shortcut key to make it
more readily available. If you aren’t sure where you want to assign your
macro, you can create it first and then assign it later.

How to Run a Macro from the List of Macros
1 On the Tools menu, point to Macro, and then click Macros.
2 In the Macros dialogue box, in the Macro name box, click the appropriate
macro and then click Run (or double-click the macro name).
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Macros are not separate files, and they work only in conjunction with the
document or template for which they were created. Only the template or
document that is currently active will be modified by any macros that you
create. When you create a new document, Word uses the Normal template by
default.
Before you run a macro, position the insertion point where you want the result
of the macro to be displayed. For example, if you are creating a macro to
insert a table, click where you want the table to appear.
Sometimes a macro does not work as you expect, so you need to modify it.
You can re-record the macro to correct the problem.
A macro virus is a type of computer virus that is stored in a macro within a file,
template or add-in. For the best protection against macro viruses, you should
purchase and install specialised antivirus software.
To further reduce the risk of macro infection in any files, set the macro
security level to High or Medium, and use digital signatures. To set the macro
security level, click the Tools menu, click Options, click the Security tab,
click Macro Security, click the Security Level tab, and then select the
security level that you want to use.
When you no longer need a macro, or if you want to remove a poorly
functioning macro to re-record it with the same name, you can delete it.
Deleting a macro is straightforward, but after you delete a macro from the list
of available macros, you also need to delete its associated toolbar button or
menu command (if you created one).

Toolbars
Toolbars can be viewed from the View menu. There are a number of predefined toolbars that are permanently displayed whenever you open a
program. These include the Standard and Formatting toolbars. You can also
amend or attach macros to buttons on an existing toolbar or create you own
customised toolbar. Remember when you delete the macro to delete any
associated toolbars or buttons you created to run the macro.
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To customise a toolbar or a command, open the customise design box from
the View menu, Toolbars. You should see a screen which has two or three
tabs — one for toolbars, one for commands and one for options on
customisation.

Packaging Your Presentation for CD
If you want to use another computer to run your presentation you can copy it
to a memory stick or burn it to CD and either run it from that or copy it onto the
other computer and run it from there. Using this method means that a version
of PowerPoint that’s compatible with yours must be installed on the other
computer.
If the other computer doesn’t have a compatible version of PowerPoint, you
can still run your presentation as long as PowerPoint Viewer is installed.
PowerPoint Viewer is a smaller program that can be freely installed on any
computer for the purpose of running slide shows so, for example, you can’t
make any changes to the content using this program.
There used to be a Pack and Go Wizard in earlier versions of PowerPoint,
which is simply called Packaging for CD in later versions. This can be used to
pack together all the files and fonts you’ve used in your presentation and if
you’re going to use a computer that doesn’t have PowerPoint on it, you can
include the PowerPoint Viewer program. The packed presentation can be
saved either to a removable disk like a CD or to a network location if that’s
more convenient.

Packaging Your Presentation
Depending on which version of PowerPoint you have, select the File, Pack
and Go menu option to start the wizard or File, Package for CD. At each
step you’ll be asked to specify what’s to be packed and where the package is
to be put. These steps are explained below.
1 Choose which presentation to package.
2 Set where the packaged files are to be saved.
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3 Chose which elements are to be included in the package.
4 Choose whether to include the viewer program (usually a good idea).
5 Choose whether to apply security on the packaged presentation.
6 When the files have been packaged, you should check they can open on a
machine that does not have PowerPoint installed. This makes sure the
PowerPoint viewer is working correctly.

Exercise 5: Using Design Templates
In this exercise you’ll use a copy of the presentation you saved in the Student
Files folder earlier.
1 Open the Company Restructuring file stored in the Presentations folder
in your Student Files folder.
2 Apply the design template called Cascade to this presentation by selecting
the Apply Design Template option from the Common Tasks button.
All the slides in your presentation now use the Cascade template.
3 Following the instructions below, change slide 5 (Alternatives
Considered) to a Text and Clip Art layout.
Select the Text and Clip Art option then click the Apply button.
The slide will now look like this (the coloured background has been
removed from the slides in this exercise so that you can see the detail that
you’re working with):
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4 Insert the following clip art image by double-clicking the placeholder and
then choosing the image shown below from the People category.

5 Change the layout of the last slide and insert the following Business clip
art image so the finished slide looks like this:

6 Save the presentation as Company Restructuring 2-2.ppt in your
PersonalStuff folder and close the presentation.

Exercise 6: Using Graphics and Clip Art
This exercise uses another copy of the Company Restructuring presentation.
1 Open the Company Restructuring 2-3 presentation stored in the
Presentations folder in your Student Files folder.
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2 Following the instructions below, import an arrow image into your clip art
library.
Click the button to display the clip gallery.
Click the Import Clips button shown at the top of the Insert Clip Art
dialogue box.
Display the Presentations folder in your PersonalStuff folder in the Look
in box and then select the image called Arrows6.wmf.
Click the Import button.
Enter red triple arrows into the Description of this clip box.
Click the Categories tab and select the Shapes category from the
displayed list.
Click the Keywords tab then click the New Keyword button.
Type arrow in the New Keyword box.
Click OK then add another keyword trident.
Click OK to add the image to the clip gallery.
Now click the button to redisplay all clip art categories.
3 Following the same procedure as outlined above, add the following images
stored in the Graphics folder to the clip art library.
File name

Description

Category

Keywords

Champagne.wmf champagne bottle

Food & Dining

bottle, champagne

Soccer.wmf

Sports & Leisure

football, footballer

footballer

4 Close the Clip Gallery dialogue box.
5 Make sure the first slide in the presentation is displayed then click the Clip
Art button.
6 Type red arrow into the Search for clips box and press [Enter].
Since you saved the first clip with these words in the description, it is listed
as matching your search.
Add this graphic to the first slide.
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7 Resize the arrow image by clicking a corner handle and dragging towards
the centre of the image to make it smaller. Once you have made it smaller
drag it to its new location as illustrated below.

8 Display slide 7 (Our Vision for the Future) and following the instructions
below change the choice of bullet used on this slide to a square-shaped
graphical bullet.
Select all the text on slide 7 and then choose the Format, Bullets and
Numbering menu option.
Click the Picture button and then choose a red colour square bullet from
the images shown within the clip gallery.
Select the Insert clip button.
9 Change the bullets to numbers by selecting the bullet point text and then
clicking the 1,2,3 Numbering button.
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10 Change the formatting of the numbers using the Format, Bullets and
Numbering menu option so they are displayed as illustrated below.

11 Save the changes you’ve made to the presentation then close it.

Exercise 7: Printing a Presentation
This exercise uses another copy of the Company Restructuring presentation.
1 Open the Company Restructuring 2-4 presentation from the
Presentations folder in your Student Files folder.
2 Make sure your name appears on the title slide then type the following
speaker notes for the opening slide: Explain presentation will take
approx. 20 minutes. Ask audience to leave questions to the end.
3 Display slide 2 and type the following speaker notes into the notes pane:
Actual sales performance for each branch was as follows:
North: -23%; Midlands: +14%; South: +12%
4 View your slides in black and white by clicking the Greyscale Preview
button shown on the Standard toolbar. Click this button again to redisplay
the presentation in full colour.
5 Following the instructions below, select to print the title slide on a full A4
page (or A4 acetate).
Select the File, Print menu option.
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To print only page 1, enter 1 into the Slides box and specify from the Print
what list the option for Slides, then click OK.
6 Following the instructions below, select to print all slides as audience
handouts with six slides to a page.
Select the File, Print menu option.
Set the Print range to All, Print what as Handouts and specify six per
page, then click OK.
7 Using the print options, select to print the first two pages of the
presentation as Notes Pages for the speaker.
8 Save and close the presentation.

Exercise 8: Using Rotate, Copy and Flip
In this exercise you’ll open another copy of the Promotion presentation you
saved in a previous exercise.
1 Open the presentation Promotion 2-8 stored in the Presentations folder
in your Student Files folder.
2 Display slide 6 (Post Match Party), then following the instructions below
make a copy of the arrow using drag-and-drop.
Click the arrow to select it.
Hold down the [Ctrl] key and, using the mouse, click and drag the arrow to
make a duplicate. Make sure you release the mouse button before
releasing the [Ctrl] key or the duplicate will not appear.
3 Create another copy of the arrow, this time using Copy and Paste.
Select one of the arrows displayed on your slide and click the Copy
button.
Select the Paste button and the new arrow will appear. This button looks
like this:

.

Drag it to the left of the champagne bottle.
While the new arrow is still selected, choose to Rotate or Flip, Flip
Horizontal from the Draw menu.
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4 Copy the arrow you just flipped and add the text boxes as illustrated
below.

5 Format the Retail buyers as 20 point and italic.
6 Follow the instructions below to copy this formatting to the other text labels
on this slide using Format Painter.
Hold down the [Shift] key and click the Retail Buyers text box to select it.
Double-click the Format Painter button.
Now click each of the other text boxes on the slide so all are formatted in
the same way.

Press [Esc] or click the Format Painter button again to switch it off.
7 Follow these steps to add a link to the Museum page on the Scottish
Football Association website to the We Have Kick Off! slide.
Display this slide.
Add a text box that reads SFA Museum to the bottom right of the slide.

Presentations Student Workbook — Beginner/Intermediate/Advanced

89

PC Passport Support Materials

Select the text box by clicking its border.
Select the Insert, Hyperlink menu option and make sure that Existing
File or Web Page is selected in the Link to bar at the left of the dialogue
box.
Important: If you don’t currently have access to the internet, type the
following into the Type the file or Web page name box and jump to step
8 below: http://www.scottishfa.co.uk/museum/index.htm
So that you can browse to find this page, click the Web Page button under
Browse for.
Your web browser program starts and your Home page is displayed.
Type the following address into the Address box in your browser:
www.scottishfa.co.uk
Click the Museum link at the left of the SFA Home page.
Minimise your web browser to return to PowerPoint — don’t close it.
The web address you last visited is entered into the Type the file or Web
page name box.
Click OK to add the hyperlink to the selected text box.
Return to your web browser program and close it.
8 If you have access to the internet, follow these steps to view the hyperlink.
To view the hyperlink in action, you have to view the slide in Slide Show
view.
Make sure the We Have Kick Off! slide is displayed.
Select the View, Slide Show menu option.
Point to the SFA Museum text and notice that the mouse pointer changes
to a hand to show that this is a hyperlink (or simply link).
Click the link.
The SFA Museum page opens in your web browser.
Close your browser window to return to PowerPoint.
9 Save the changes you’ve made to the presentation, then close it.
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Finally
The candidate should (after consultation with their tutor) be able to do the
assessment for this Unit.
This completes all the learning Outcomes for the PC Passport Presentation
subject. Microsoft PowerPoint is one of a range of presentation software that
could be used to achieve the same results.
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